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About MESA 1l

Modular Editing System by AKAI

Centralized control of
various hardware de-
vices and data trans-
fer

Save time and gain
finer level of control on
a large screen with a
top-notch Graphical
User Interface

Interface between in-
compatible machines

Automate tasks such
as batch updates, pro-
gram generation or
setup procedures

Familiar, easy to oper-
ate and well written
interface

MESA Il is the computer based software system that provides the centralized control of
hardware operation and data transfer in a wide range of AKAI Samplers and digital
recorders, etc. from a single screen on the Macintosh. It currently supports S-series
Samplers, S2800, S3000, S3200 and CD3000, and XL-series Samplers, S2000,
S3000XL, S3200XL and CD3000XL, and DD1000.

Using a computer to control external hardware devices has a number of advantages.
For instance, samples and programs can be loaded from any device into the Mac memory
and manipulated, played, and stored on any device of the user’s choosing. The audio
and parameter data can be backed-up, or saved, onto the Mac disks, and reloaded at
later time.

While those external devices like the Samplers can be operated from their own front
panel, most of them offer only small screens for the cost reason and such. The power
of MESA 1l lies in enabling access to the functions of such devices on a much larger
screen via a graphical user interface: users use the mouse to select functions, set
levels and parameter data via buttons, sliders, knobs and faders on the screen. Audio
Editing, Sample Editing, Program Generation, Storage, and File Manipulation can all
be controlled from the Mac. The convenience of a large screen graphical user interface
not only saves time and effort but offers a finer level of control to manipulate sounds
and programs.

In addition, MESA Il takes in the audio file formats of incompatible machines translating
file formats into the general audio file formats such as AIFF and SD2, thus the data
from various devices can now be manipulated as easy as working with a single ma-
chine.

MESA Il has been further expanded to be fully compatible with AppleScript in Mac
OS7.5. AppleScript provides a facility to write scripts that control the look, feel and
functionality of MESA Il and the efficiency of operation can be improved. For instance,
scripts can be written to perform batch updates such as changing the settings of sev-
eral programs with one click of the mouse, to integrate all version numbers or creation
dates of a set of files, or to gather several programs into one. Some useful script
sources are included to the MESA I, and the further scripts will be made available.
“Power users” are encouraged to adapt these and write their own to suit their method of
working.

MESA 1l has the familiar interfaces of Mac system such as drag and drop, interactive
On-Line Help, etc.

MESA Il is written as a modular system and it allows you to install only the necessary
modules to the Mac, thereby saving Mac RAM memory.

MESA Il
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Getting Started

How to install MESA I

Double click MESA Il Installer icon.

Install program is booted, and MESA 11 will itself decompress and install files into the
selected folder in your Mac hard disk.

File Configuration of MESA Il

Do not rename or
move this folder as
MESA |l needs it to
run

Moving the unneces-
sary Editor from this
folder increases the
boot up speed and
saves RAM memory.

Unnecessary plug-in
can be moved from
this folder. Error
message is shown
when the plug-in is
not compatible with
your system

When the installation is completed, the folder "MESA II" that has been created on your
hard disk contains the following folder and files:

mE=.a MESA Il
MES& 11

This is the application body itself. Double clicking this icon will boot MESA 1.

M.E.S. A

—
MES& Pouch

The "MESA Pouch" is a folder that contains an "Editor Folder" and a "Plugins" Folder
that the MESA Il application needs to run. When you boot MESA 1, it scans for the
folder called "MESA Pouch" and loads the files. If it does not find this folder in the same
location as the MESA 1I, MESA 1l will not be able to boot and the error message "Error:
Could not find MESA Pouch Folder" will be displayed.

MESA Pouch

Before starting MESA I, you can move items in or out of the Pouch depending on your
need and available Mac RAM memory.

L e—,

mE.=4 Editors Folder
Editors

This folder must be in the "MESA Pouch" folder. The Editor files that you will actually
work have to be moved into this folder. MESA Il will read the files in this folder and add
them to the menu of Editors as you boot MESA II.

MESA Il can be expanded by adding the new editor into this folder.

o e,

mE.= Plugins Folder
Fluglns

This folder must be in the "MESA Pouch" folder, and it contains various plug-in or
program files to support particular functions of the Editors. In this folder, there are two
folders ("Audio Filing" and "DSP"), and one or several separate communication files
(SCSl or OMS) .

2 Getting Started
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Useful AppleScript
file

Move the unneces-
sary files into the
MIDI stuff

* "Audio Filing" folder contains the AIFF plug and SD2 plug to translate
between different Audio files;

* "DSP" folder contains various Filters and general DSP plugs for Digital
Processing;

* SCSI and/or OMS MIDI files enabling MESA |l to communicate with ex-
ternal devices.

ME. = Example Scripts
Example Scripts

This folder contains MESA 1l script source code written using AppleScript.

MESA Il is fully compatible with AppleScript and some useful scripts are provided.
Scripts do not have to be in "MESA Pouch" folder to run. However, you must first
compile and save the scripts as applications. If your Mac is set up for AppleScript, this
is very easy. See "AppleScript" Chapter in this manual.

D OMS MIDI Stuff

aOr35 MIDT Stuff

In the "OMS (Open Music System) MIDI Stuff" folder, it contains the OMS plug-in to run
MIDI with OMS and MIDI Keyboard Editor file to play MIDI Notes on the keyboard
screen of the Mac. To install these into MESA II, move them into the Editors folder or
Plugins folder.

Note: To run MIDI with OMS, MESA Il requires OMS v 2 or later (version 2.2 is recom-
mended). For OMS availability, see "http://www.opcode.com" or contact your local
dealer. To run MESA Il with SCSI, your Sampler must have a SCSI board installed (if
SCSl is an option).

Memory System Requirements and Set-Up

Without conforming
to these require-
ments, MESA Il may
still boot but may
cause unpredictable
behavior as low in
memory, call unsup-
ported function, etc.

The following are required to run MESA 1.

* Macintosh or Power Macintosh equipped with 68030/40 microprocessor

* Mac OS7. 1 or later (7.5 is recommended)

* 4MB (4000K) or more spare RAM memory (If no sample editing is being
done, it could run with about 2500K.)

* Display with 256 or more colors.

* Sound Manager v 3 or later (version 3.2 is recommended)

* Drag and drop functions

* AppleScript (if you run the script)

* OMS v 2 or later (version 2.2 or later is recommended) (not needed if
MESA Il is used only with SCSI)

Deleting (or removing) unused Plugins and Editors from "MESA Pouch" folder saves
RAM memory.

MESA 1l may not work correctly when virtual memory is on. If you experience trouble
while running MESA Il with virtual memory turned on, turn it off. Turn RAM Doubler off
likewise.

AKAI Samplers S2800, S3000, S3200, and CD3000 must have operating system ver-
sion 2.0. The S2000, S3000XL, S3200XL, and CD3000XL must have operating sys-
tem version 1.5. To use MESA Il in a SCSI environment, the SCSI board is required for
the system without SCSI board.

MESA I
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How to setup MESA Il in a SCSI environment

Audio data transfer
from Samplers to the
MAC needs SCSI to
run

Faulty SCSI cables
cause some trouble,
use high quality
cables

Note on SCSI con-
nection

If virtual memory
causes problems,
turn it off

SCSI (Small Computer System Interface) is a fast communication protocol designed
primarily for the data transfer of computer. Because of its speed, it is the recommended
environment to run MESA Il in if you do a lot of sample data transfer. If you use the
Sampler Editor, you must place the SCSI Plug file into the "Pluglins” folder.

Boot-up procedure is as follows;
* Turn off your Macintosh and Samplers, and connect them with standard
SCSil cables.
* Turn on the Samplers.
* Turn on the Macintosh after the Samplers are booted up fully.

All types of Macintosh support SCSI, but some of the Samplers offer SCSI board as an
option. In this case, the SCSI board has to be installed in the Sampler.

While a total of 8 SCSI IDs from 0 to 7 are provided, Macintosh uses both 0 (for the
built-in HD) and 7 (for Macintosh itself), leaving you 6 IDs for external devices. AKAI
Sampler is usually set to ID 6. All other devices need their own individual SCSI IDs. If
more than one device shares the same SCSI ID number, the system will freeze or
malfunction (see "Troubleshooting" Chapter).

A further potential problem is incorrect SCSI termination. Ensure that you have termi-
nated your SCSI system correctly. Most of system freezes are caused this way.

If you turn an external SCSI device on after the Macintosh is turned on, then you must
wait for it to fully boot up before you do anything on the Macintosh. If you do not and the
Macintosh tries to access SCSI during that time, then the Macintosh will freeze.

SCSI may also cause conflict with virtual memory, including RAM Doubler. If you must
use virtual memory and experience problems, try using OMS MIDI instead of SCSI
communication. However, because SCSI communication is much faster, an invest-
ment in more real RAM is recommended.

How to set up MESA Il in an OMS Environment

For the installation of
OMS, refer to OMS
instruction manual.

The MIDI conversion
box is required to
connect MIDI cable
to the Macintosh.

Playing samples with
the Keyboard Editor
needs OMS MIDI.

MESA Il is completely compatible with OMS v 2 (version 2.2 or later is recommended).
The OMS (Open Music System) MIDI (Musical Instrument Digital Interface) Environ-
ment provides an alternative to SCSI if you do not perform large data transfer.

Set up procedure is as follows;
* Install OMS in your Macintosh.
* Connect your Macintosh and the Samplers with MIDI cables.

OMS is now an Apple standard and replaces the Apple MIDI Manager (which MESA I
does not support any longer). You can get OMS by downloading OMS from the OPCODE
web site or buying it from music software dealers.

To use OMS, move the OMS Plug file into the "Plugin” folder.

Advantages of OMS are a neat user interface and a more robust system than SCSI, i.e.
once it is set up, it runs very stable.

If you need to run the MESA Keyboard Editor (which is a MIDI object), OMS is required.
A disadvantage of using OMS is a lower speed as compared to SCSI. It is not very
practical to transfer the sample data by OMS MIDI. Therefore, it is recommended that
you install both OMS MIDI and SCSI and use each where most appropriate.

4 Getting Started
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About MESA Il developer team

MESA Il has been developed by Andy Bull of Living Memory, London as part of a
worldwide AKAI team of developers residing in Japan, Britain, and the USA.

Support

This software is bundled with the AKAI XL-series Samplers and is also available free of
charge when it is downloaded from our web site (http://www.akai.com/akaipro). There-
fore, we offer no guarantee for this software. Accordingly, the technical backup and
support on this software are not available in principle. However, your comments and
suggestions on this software are welcomed. Please forward them to the EMI Division
of AKAI Electric Co., Ltd. or your local AKAI distributors.

Software Protection and Copyright

The copyright of this software is owned by AKAI Electric Co., Ltd. and Living Memory. It
is prohibited to copy, for the purpose other than making personal backups, or distribute
this software without prior permission.

AKAI Electric Co., Ltd. and Living Memory disclaim all the responsibility for all the harm

or damage to users caused from the use of this software, and make no compensation
for them.

Macintosh is registered trademark of Apple Computer, Inc. All other product and com-
pany names are the property of their respective owners.

MESA I
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New Functions

A much neater con-
ceptual operability

Editors made for
specific purposes -
select Editors you
need to work with

New Tools

Load several wave
samples and cut and
paste between them
Create a database of
your Sampler HD

Access all functions
from a single screen

Mixing programs
made easier

Select the Plugins
you need before
booting MESA Il

MESA Il is a major update from earlier versions of MESA. The interactivity of the
program has been drastically enhanced, resulting in an easier-to-use interface for pro-
fessional sound engineers while offering an extended set of sophisticated functions for
the ‘power user’.

Editors

MESA Il is now based around the two main concepts of Editors and Plugln files sup-
porting the chosen Editors.

Editors, particularly the Audio Editor and Sampler Editor, are now the main access
points in MESA II. Other Editors currently shipped include the DD1000 Transfer Mod-
ule and the MIDI Keyboard. New Editors will be added in the near future.

Audio Editor
New Audio Editor Tools and functions included:
* ‘Scratch’ Loudspeaker Tool to playback the audio by “dragging” the mouse
over it;
* Pencil Tool to edit the waveforms directly as rubbing out the noise with
the mouse;

* Stereo sample waveforms of both left/right channels are shown.

* Editing/DSP on either L/R samples individually or both at the same time.

* Users can open multiple Audio Editor Windows (memory permitting) and
place audio waves side to side.

* Users can drag and drop between different windows.

Sampler Editor

New functions include the facility to create a database (on the Mac) of references to
the files on the Sampler HD. You can then rearrange this database into your own
Finder hierarchy of folders and files, and load your Sampler files from there.

As a new function of Sampler Editor, Layout Files (e.g. MIDI Setup, Filters or LFOS)
have been redesigned and are now all accessible by pull-down menus from a new
“Super Layout” called the Control Center.

With the Quick Access Window, the key parameters of the programs and keygroups
can be manipulated in a single screen.

Plugins

Plugins are a set of MESA Il extensions handling such functions as Audio Format Trans-
lation between incompatible audio formats and Communication Protocols such as SCSI
and OMS. While varieties of Pluglns are included in MESA I, you only install those
functions you need by dragging them into “MESA Pouch” Folder before starting MESA
I.

6 New Functions
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All menu options are
now accessible from
a single menu bar

Use drag and drop -
it's fast and doesn'’t
prompt you with dia-
logue boxes

Edit any selection of
keygroups at the
same time

Use the clipboard to
transfer audio
samples

Short concise de-
scriptions of con-
trols, menus, and
functions in the Help
System

Dynamic Menu Bars

All menu bars are now dynamically interactive and display a specific set of menu op-
tions - dependent on where the user is within the program. For instance, if the Sampler
Editor is chosen, the menu bar shows the specific menu options like Sampler and
EB16.

Drag and Drop

Drag and drop function has been extended. For instance, sound samples can be played
from the Mac Finder by dragging an AlIFF sound file and dropping it into the MESA II
icon. Within MESA I, drag and drop is enabled between individual windows. For
example, dropping a sound file over the Audio Editor from the Finder or the Sampler
Editor renders this file ready for audio editing.

Keygroup Batch Editing

A discontinuous set of keygroups can be selected and batch edited by using the Shift
key in the Program Selector Window.

Clipboard Integration

Audio samples can now be copied and pasted to the Mac Clipboard as Mac standard
16 bit ‘snd’ format resource files. You can even click on a clipboard sound and play it
over the Mac speakers.

Sampler Integration

MESA Il now sends program changes to the Sampler in real time whenever the user
selects a program to edit.

Finder Integration

The Sampler Editor now creates a full database of all Sampler files and folders on the
Mac Finder. With this, you can organize files on the Finder.

On-Line Help

A ‘Balloon’-type On-Line Help System has been implemented. By selecting “Mesa
Help” under the Mac Help Menu icon at the top right corner of the screen, the cursor
changes to a “?” question mark. When the user clicks either on MESA |l Menus or on
objects within a MESA 1l Window while the cursor is in question mark, their brief de-
scription will be displayed. Help is thereby fully integrated within MESA Il obliterate the
need for extra Help Files. Shortcut keys to the Help Menu are “Command + H” keys or
“Help” key.

MESA I
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Scripting

‘Power Users’ will With a dictionary of MESA Il objects provided, writing AppleScript has been made easier
find writing to use scripting functions. Some useful scripts have been provided. As AppleScript
AppleScript a lot must be integrated with the hardware and software setup of individual systems, these

scripts are included in text format and must be compiled before they can be run. Refer
to the MESA 1l “AppleScript” Chapter for further information.

more convenient

8 New Functions MESA Il



Tutorial

Application Made Easy to use

You will find it easier
to digest this manual
if you first work
through the Tutorial

This simple Tutorial is written to provide a quick 'hands-on' overview of MESA II. It will
take about half an hour to work through. This chapter, by the way, is described on the
assumption of that the Macintosh and Sampler are connected without having any trouble,
and MESA Il has been installed properly. For the set up of MESA II, refer to "Getting
Started" Chapter.

In particular, you will learn to
1. load MESA II;
connect to a Sampler;
load disk data into the memory of Sampler;
move sample data into your Mac;
edit a sample;
save a sample;
create a new program;
assign a single sample to a program;
create a more sophisticated program; and
10. save a program

© o N DN

Step 1: Starting MESA I

If you can't start
MESA Il, consult the
Troubleshooting
Chapter

If you don't see the
three Editors in the
Editors Menu, check
the contents of Edi-
tors Folder and re-
start MESA 11

* Double click on the MESA Il icon. RE=4

MESA Il title appears. After loading the Editors and Pluglns, one or several MESA
windows will open up - MESA Il opens up where it was Quit the last time.

You should see the menus File, Edit, Editors on the menu bar, and depending on which
Editor happens to be selected, some further menus such as Sampler/Windows (Sam-
pler Editor) or View/DSP (Audio Editor) will appear. For this tutorial, you need the
following three Editors installed: Audio Editor, Keyboard, and Sampler Editor. Check
that they are present under the Editors Menu.

Note that even when there are no windows open, one of the Editors will be active and
marked with a tick under the Editors Menu. On the menu bar, the Menu for this Editor
is shown.

Step 2: Connecting to a Sampler

If you cannot con-
nect to your Sam-
pler, see 'How to
setup MESA Il in a
SCSI (or OMS) En-
vironment' above

* Select the Sampler Editor from the Editors Menu, and select "Find Sampler..." from the
Sampler Menu.

Depending on whether you use OMS or SCSI for communicating with your Sampler,
one of the two message boxes will appear.

When SCSI is used;
* Select your Sampler's SCSI ID (default 6) and click OK.

If you selected a wrong SCSI ID, hold down the keys "Command + .(Period)" to undo

MESA I
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the selection.
When OMS is used;

* Select the name of your Sampler and click OK.

* Select "Memory" (Command + 3) from the Windows Menu to open the Memory Win-

dow.

The AKAI Sampler contains the TEST PROGRAM and 4 sample data in default. Check
if they are displayed on the Memory Window.

niEnl U TEST PROGRE &

FrFograms Rl 2hEr Samples
#TEST PROGR Al 1 1 [1¢| PULSE it
SAawWTOOTH
*5|ME
SOUARE

Step 3: Loading disk data into the memory of Sampler.

With an old Mac Os,
drag and drop may
not work. You can
use the menu bar or
double clicking in-
stead

If you can't hear a
sample, play it di-
rectly from your
Sampler

* Select "Disk" (Command + 4) from the Windows Menu, and the Disk Window will open

up.
Insert the sample floppy disk included with AKAI Sampler into your Sampler.
Click the floppy disk icon shown at the left top of the Sampler Disk Window.

This accesses the Sampler's floppy disk, and the contents of disk will be shown on the
Window. (If the diamond shaped icon is clicked, the SCSI devices (hard disk, CD-ROM
drive, etc.) connected to your Sampler will be accessed.)

Click the program or sample on the window to select the one you want to load.

The selected item will be shown reversed. If you want to select several items, click
them while holding the Shift key pressed.

Drag the selected items and drop them on the Memory Window.

The selected items are now added to the Sampler's Memory. You may also load them
by double clicking the selected item, or selecting "Load Selected Items..." from the File
Menu (In this case, you can clear the old samples in the Sampler's Memory before
loading the new samples). You can play the samples loaded in the Sampler's Memory
by selecting samples one at a time and clicking the speaker icon at the top right hand
corner in this window. They will be played through the audio output of the Sampler.

e

Step 4: Loading sample data into the computer memory

To load the sample data from your Sampler memory to your Mac memory;

* Select "Audio Editor" from the Editors Menu.

A large Audio Editor Window called "untitled" together with a Toolbox Window and an

10 Tutorial
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If a sample is too
large to load into
Mac memory, you
will have to adjust
the memory by clos-
ing MESA II, clicking
its icon on the Finder
and selecting "Get
Info..."

empty Information Window will appear.

Editars ‘Wiew

J S kit Tes

" & File Edn

* Select a sample from the Memory Window and drag and drop it into the "untitled"
Window. To load stereo samples, select both left and right samples and drop them.
The Audio Editor Window is now filled with the selected samples' wave form and the
Information Window shows the information about the samples.

* Press the Spacebar.

The samples on the window will be played. To stop playing, press the Spacebar again.
Since these samples are on the Mac memory, they will be played from the speaker
built- in the Mac.

Step 5: Editing a sample

To use DSP func-
tions, the DSP
Plugins has to be
contained in the

You can edit a sample using a DSP (Digital Sound Processing) function in Audio Editor.
DSP functions work only on the selected part. Selecting the whole sample ( Select All
in Edit Menu) or selecting a part thereof renders the DSP Menu active, i.e. its color
changes from gray to black.

* Select the Selection Tool (the "bar" icon in Toolbar Window, top right) of Audio Editor.

MESA Pouch I |
The shape of Cursor is changed to an "I" beam shape.
* Drag it on the wave form to select the part of a sample.
The selected part is displayed in reversed color, and only the selected part will be
played when the Spacebar is pressed. To adjust the right and left margins of the se-
MESA Il Tutorial 11



lected part, the Shift key and Selection Tool are used. Click anywhere outside the
selected part to deselect.

The Information Window shows the beginning and end locations of the selected part.
* Select "Reverse" from the DSP Menu.

The selected part is now reversed. Only the edited part will be played when the Spacebar
is pressed.

* Select the Selection Tool, and click anywhere outside
the selected part of wave form in the Audio Editor Window.
Everything will be deselected, and pressing the Spacebar will play the whole sample.

Try the same steps for other selections and other DSP functions. If you want to use the
Audio Editor more seriously, you will have to use Rulers, Markers, and other functions
as described in the "Audio Editor" Chapter.

Step 6: Saving a sample

To save the sample edited by the Audio Editor to the Sampler Disk;
* Display the Memory Window on the Sampler Editor.

Keep the Memory Window visible even when the screen is changed over to the Audio
Editor.

* Select the Drag Tool on the Audio Editor.

9|

The Cursor is now changed to the shape of a hand.
* Drag the wave form on the Audio Editor Window, and drop it on the Memory Window.
Now the sample has been sent to the Sampler's Memory.
* Display the Sampler Disk Window on the Sampler Editor.
Check if there is a floppy disk to save in the Sampler.
* Drag and drop the sample from the Memory Window to the Disk Window.
Now the sample is saved on the Sampler disk.
You can also save a sample by selecting "Save" from the File Menu.
Next, to save the sample edited on the Audio Editor onto the hard disk of your Mac;
* Select "Save" from the Audio Editor File Menu.
You will be prompted to select the saving location and saving type as you save.

You may also drop the sample from the Audio Editor Window directly onto the Finder
using the drag tool.

Furthermore, the sample on the Sampler can be saved directly to the Mac disk.
* Open the Memory Window on the Sampler Editor, and select "AlIFF" or "Sd2f" in "Ex-
port Sample..." on the File Menu.

You will be prompted to specify the saving location as you save. You may also drag the
sample you want to save and drop it directly onto the Finder.

12 Tutorial MESA Il



Step 7: Creating a new program

To create a new (empty) program;

* Open the Memory Window on the Sampler Editor, and select "New Program" from the

File Menu.

Input the name as a dialogue to allow you to name the new program appears.

Flease name the program:

* Input "TEST" and select OK.

Next, to set the MIDI channel of program to 2;

* While holding down the Option key, click the channel number and input "2" - the default
MIDI channel number of the new program is set as "1".

We will next assign samples (each with a different key span) to this program, and play

it in the Key Span Window.

Step 8: Assigning a single sample to a program

To enable the func-
tion of the Keyboard
Window, OMS has to
be installed

Move Keyboard file
into the Editors
Folder in the Pouch

To assign a sample to the program "TEST" created in the previous section;

* Select the Sample Assign & Key Span (Command + 2) from the "Windows" Menus, and

open the Sample Assign & Key Span Window.

* Select the sample "SINE" from the pull-down menu in the Velocity Zone 1.

Zr

SIME

1
2
2
4

-
-
-
-

There are other alternatives to assign samples to programs: you could use the Control
Center Window, Sample Assign & Key Span Window, or the Quick Access Window.
The quickest and most simple way to create a one-sample program is to use the Quick

Access Window.

Try playing the program now.

* Click the Keyboard on the Sample Assign & Key Span Window with the mouse.

If the control of a program assignment is made via MIDI, you can play the program in
the MESA Keyboard Window as well if you have OMS installed. To display the Key-
board Window, select the "Keyboard" from the Editor Menu. You may directly play the
Sampler with the external MIDI Keyboard connected to the Sampler.

MESA I
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Step 9: Creating more sophisticated programs

The Control Center,
and the Program
Selector are de-
scribed in details in
their own Chapters

To create a more sophisticated program with several samples assigned in the Sampler
memory, we need to add further keygroups containing further samples to our program.

Now open the Control Center Window by selecting the Control Center (Command + 1)
from the Window Menu. This gives you full control over all program parameters. The
Control Center Window is divided into several sections, each incorporating a pop-up
selection menu on top, allowing you to set different parameter in each section. When
the Control Center Window is opened, the Program Selector Window opens up auto-
matically.

To add a keygroup to the "TEST" program which we have just created;
Select the programs and keygroups in the Program Selector Window and click the +
sign.

The keygroup 2 has been added. When editing only the keygroup 2, click the number
2 in the Program Selector Window.

4 [=[1 H

Select the sample "SQUARE" from the pop-up menu of Velocity Zone 1 Section on the
Control Center Window.

Now the new sample is assigned in the keygroup 2. If you switch back to the keygroup
1, you will see the sample "SINE" in Velocity Zone 1.

If you now play the program, you will hear both samples playing together on all notes.

Next the samples are assigned to the specific ranges of the keyboard to create the
Keyboard split;

Open the Sample Assign & Key Span (Command + 2) Window.

2 keygroups are shown on the screen and the samples "SINE" and "SQUARE" are
assigned on each Velocity Zone.
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Drag the left half of span bar of the keygroup 2 with the mouse, and slide it up to C4.
At the upper left of Window, the note number which has just dragged is shown.

Drag the right half of span bar of the keygroup 1 with the mouse, and slide it down to
B3.

Now the sample sound played will be changed over B3 and C4.
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Now let's play this program. At the lower half of the Keyboard, "SINE" is played, and at
the higher half of the Keyboard, "SQUARE" is played. With repeating this procedure,
many more keygroups can be created in the Program Selector Window.

The whole program setting and the sample parameter control can be performed only in
the Control Center Window. Here, we will make a wide spread stereo program using
only one sample, "SAWTOOTH".

* Select the New Program from the File Menu.
* Name the program "STEREQO" as the dialogue box prompts.

* Open the Control Center Window, and switch over to the MIDI Setup section by using
the pop-up menu of the Output & Levels section.

* Set the MIDI Channel number to 3.

* Select the sample "SAWTOOTH" from the Sample pop-up menu of both Velocity Zone
1 and Velocity Zone 2.

* Set the pan to left channel (-50) in the Velocity Zone 1 section, and to right channel (50)
in the Velocity Zone 2 section.

* Set the High Velocity Zones (Hi V) of both Velocity Zone 1 and Velocity Zone 2 to the
maximum 127 and the Low Velocity Zones (Lo V) to 0.

* Set the Cent of Velocity Zone 2 section to 10.

* Now you can play the stereo program.

Step 10: Saving the program

To save the previously created program "TEST" to the Sampler disk;

* Select the program "TEST" in the Memory Window, and select "Save..." from the File
Menu.

* You might be prompted with a dialogue box asking you to first select a Volume and
Partition on the Sampler hard disk to save it to, before you save the program.

You will also be given the option to save the associated samples with the program.
Next, to save the last created program "STEREQ" to your Mac disk;

* Select the program "STEREQ" in the Memory Window, and select "Export Program..."
from the File Menu. You will be prompted with a dialogue box to name.

* Input a file name, and then select where you want to save it to your Mac disk.

You can also save to your Mac by drag and drop from the Memory Window to the
Finder.
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Overview of MESA |l Editors

About MESA Il Editors

Boot several Editors,
and open several
screens for each
Editor at the same
time

MESA Il is operated in the scope of each Editor. Those Editors supported are, the
Sampler Editor, Audio Editor, Keyboard Editor, and DD1000 Module. Several other
Editors will be added in future versions. When you start MESA I, the editor files in the
Editors Folder will be loaded in. The Editor is selected from the Editors Menu. A tick
appears on the left of the active Editor.

Some Editors automatically open one or several (empty) editing windows for you. You
can then load a sample or program in to these windows. By default, these windows are
left open when you load to another Editor. You can therefore see the state of several
Editors on the same screen. Clicking on any Editor Window activates the Editor related
to that Window.

The menu bar of MESA Il changes its display according to the Editor that is active.
However, as the Editors Menu is shared by all Editors, you can activate any of the
Editors installed from this Menu.

Overview of Sampler Editor

Use for creating and
editing the programs

Organize the pro-
grams and samples
in the Sampler by
linking aliases to the
files you need to
work with - then
move these aliases
in your own files and
folders on the Mac

The Sampler Editor can control almost all the functions of the AKAI Sampler. Besides,
it can perform the import/export of samples and programs between the Mac and other

external devices connected to the Sampler.
The Sampler Editor provides the following windows;
Program Selector: Programs and keygroups are selected.

Control Center: From this Window, almost all program parameters such

as output levels, filters or velocity zones are controlled.

Sample Assign & Key Span: Sets samples and their key span for each keygroup in a
program.

Memory:

Disk:

Quick Access:

Multi Mode:
Mute Groups:

FX Routing & Selection:

Ring Mod/Distortion:
4 Band EQ:
Modulation:
Delay/Echo:
Reverb:

FX Filing & Naming:

Displays the programs and samples in memory in the
Sampler connected.

Displays the contents of disk connected to the Sampler.

Provides the layout to make the quick setting of pro-
grams and their key span.

Sets Multi mode parameters.

Sets the Mute Groups in a program.

Routes the Effect and selects the Effect Set.
Sets the Ring Modulator and Distortion.
Sets the 4 Band Equalizer.

Sets the Modulation.

Sets the Delay/Echo.

Sets the Reverb.

Copies the Effect Set and changes the Name.

Furthermore, the Sampler Editor can make the exchange of the file data with the Mac

16 Overview of MESA Il Editors
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Finder easy. The programs and samples created on the Sampler can be saved as the
files on the Macintosh. Besides, a database of SCSI disk connected to the Sampler
can be created on the Finder. If the disk contents of Sampler is changed, the database
has to be recreated to reflect the changes.

Overview of Audio Editor

Use for editing
samples

The Audio Editor lets you record, playback and manipulate individual Sound Samples.

This Editor has the several editing functions such as DSP editing, Zoom view, and Loop

Switch.

The Audio Editor provides following Windows;

Audio Editor: This is the main Window. This shows the wave form of samples
loaded. The sample name becomes the Window title.

Toolbar: Selects several tools like a play button, a selection tool, or a zoom
tool to work on your sample.

Information: Displays the information such as the sample rate, sample length,
start/end points of loop, or sample name.

Record: Used when making the sampling on your Mac.

You can have several Audio Editor Windows open - while the Toolbar Window always
stays the same, the Information Window will relate to the Audio Editor Window that is
active (i.e. selected Window).

Overview of Keyboard Editor

With the Keyboard Editor, a simple Keyboard Window is displayed on the Mac screen
and it provides a simple facility to play your program using the mouse. It is useful for
testing your program when you have temporarily no access to a MIDI Keyboard. The
OMS has to be installed when the Keyboard Editor is used.

Overview of DD1000 Transfer Module

The DD1000 Transfer Module provides Audio File Transfer between the DD1000 and
MESA Il via SCSI. You can use drag and drop to transfer audio files between the
DD1000, the Mac itself and any hardware devices attached to the Mac via MESA 1.

MESA I

Overview of MESA Il Editors 17



The Sampler Editor

In this chapter, the menu command and window of the Sampler Editor will be explained.

Selecting the Sampler Editor from MESA Il Editors menu opens up one of the Sampler
Editor Window.

File Menu

New
Depending on the currently active window, one of the following alternatives is pre-
sented.

New Program... (normal operation with a single program)

Creates a new program.

New Volume... (Disk Window is active and SCSI disk is mounted)

Creates a new volume on a Sampler hard disk. Due to the restriction of
communications protocol, volumes cannot be renamed using MESAIl. This
can only be done from the Sampler's front panel.

New Multi File... (Multi Window is active)
Creates a new multi file.
Open...

This is not active. When the item is selected at Disk Window, it is replaced with "Load
Selected Item..." and loads the selected item to the Sampler.

Close

Closes the current active window.

Save...

Saves the selected item, multi file, and effect file in the Memory Window to the currently
selected partition and volume in the Disk Window.

Import Sample

Transfers the audio file (AIFF or SD2 format supported) saved in the Mac hard disk to
the Sampler. It can also be done by drag and drop from the Finder to the Memory
Window.

Export Sample

Saves the audio file on the Sampler to your Mac hard disk. Possible to export to the
AIFF or SD2 formats with the current version. It can also be done by drag and drop
from the Memory Window to the Finder.

Import Program.../Import FX File...

Transfers the program created on the Mac hard disk to the Sampler. The related samples
can be transferred at the same time. This can also be done by drag and drop from the
Finder to the Memory Window. When the Effect Window is open, the effect files can be
transferred.

18 The Sampler Editor
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Create Mac aliases
to the files you often

Export Program.../Export FX File...

Saves the selected program to your Mac hard disk. The sample can be exported at the
same time in the AIFF format. It can also be exported to the Finder by drag and drop.
When the Effect Window is open, the current effect files can be exported.

Rename current Program...

Renames the current program being edited.

Create Disk Database...

Creates a set of folders and files that reflects the contents of Sampler hard disk on the
Mac hard disk. You can search the file on the Finder. Double clicking on a file or a folder
will load the programs and samples into the Sampler.

use - store them un- Quit
der the Apple Menu Exits MESA II.
Edit Menu
Undo
Undoes the very last action whenever possible. Not supported with the current version.
Cut
Cuts the selected part, and copies it to the clipboard.
Copy
Copies the selected part to the clipboard.
Paste
Pastes the contents of the clipboard at the mouse selected point.
Clear
Displayed as Delete Selection in the Memory Window and Disk Window, and it deletes
the selected item. It deletes the Part in the Multi Window.
Select All
Selects all selectable items in the active window.
Select None
Deselects all selected items in the active window.
Select All Programs
Selects all programs in the Memory Window.
Select All Samples
Selects all samples in the Memory Window.
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Duplicate Program...

Duplicates the current program being edited.

Duplicate Keygroup(s)

Duplicated the current keygroups being edited.

Sample Menu

If possible use SCSI
rather than OMS
MIDI- it is much
faster

For "fast mode" de-
select this item

Default SCSI ID is 6
You can also use

keyboard shortcuts
Command + "+" to
add, or Command +
""to delete

Use MIDI / Use SCSI

Selects MIDI or SCSI for communicating with the external devices. If you are using
MIDI, the menu will read "Use SCSI", and if you are using SCSI, it will indicate "Use
MIDI".

To perform the MIDI communication, the OMS Plug file must be moved in the Plugins
Folder. See the chapter Getting Started.

Send Continuous Data

Choosing this option, a tick appears beside the menu, sends the continuous data stream
of changes to the Sampler in real time while you are altering controls in the Control
Center Window. If this option is off, the data is only sent after you let go of the control.

Find Sampler...

Connects to the externally connected Sampler of your choice. When the dialogue is
displayed, input the SCSI ID of the Sampler you want. When MIDI is used, select the

name of Sampler. To cancel, press Command + "."(period) keys.

Add Keygroup

Appends a new keygroup to the current program being edited.

Delete Keygroup

Deletes the last keygroup from the current program being edited.

EB16 Menu

When the EB16 Effect board is installed in the Sampler as an option, you can open the
Editor Windows of each effect. This Menu will be active when operating under the
above mentioned Windows.

Edit FX1/Edit FX2

Selects the Effect set to edit. Atick mark appears on the selected Effect set.

Edit RV1/RV2/RV3/RV4

Selects the Reverb to edit.

20 The Sampler Editor

MESA Il



Program Selector Window

To select a set of dis-
continuous keygroups,
hold the shift key
down and click

The Program Selector Window lets you select the program and select, add and delete
the keygroups, and the on/off control of Solo function.

5 Pragruan |TEaT Fragede [ = T
Frgwat ke o E- ]
Program: Selects the program to be edited. This program can be
edited on the other Windows.
Solo Button: Lets you play the selected program only.
Keygroups: "+"and "-" buttons let you add/delete the keygroups.

Keygroups to Edit: Selects the keygroup to be edited.

When the "+" button is clicked, the new keygroup will be added to the end, and when
the "-" button is clicked, the last keygroup will be deleted. However, you cannot delete
keygroup 1. You can also add/delete keygroups from the Sampler Menu.

When E mark is selected, all keygroups will be edited. If you want to edit the specific
keygroup, click on the keygroup number to select.
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Control Center Window

The main access
Window to edit pro-
grams

For detailed informa-
tion, select "Turn on
MESA Help" under
the "?" Menu and
click buttons and
menu controller.
Shortcut is Com-
mand + H.

The Control Center Window provides almost all controls that are used to create and
edit a program from the front panel of Sampler.
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The Control Center Window is divided into the several sections, and the pop-up menu
at the top of each section lets you choose the section to edit. For example, the top left
section can be used as either "Output & Levels" or "MIDI Setup". Also, "blank" selec-
tion in each pop-up menu lets you blank out the section not used. This increases the
display speed.

The layout of Control Center Window is always saved when closed or quit. When you
reopen the Window or restart MESA I, the Control Center looks the same as when you
used it the last time.

When the Control Center Window is opened, MESA Il opens the Program Selector
Window automatically.

Followings are the explanation for each section. Refer to the Operator's Manual of the
Sampler for the function of each parameter.
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Output & Levels

This section lets you set the parameters related to the output of the program.

MIDI Setup

This section lets you set the MIDI related parameters of the program.
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Tuning & Bend

This section lets you set the parameters related to the tuning and bend of the program.

Tuning &
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Portament

This section lets you set the parameters related to the portament of the program.

Hortannento
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Filter 1

This section lets you set the parameters related to the Filter 1 of the program.

F1lter 1
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Modulation

This section lets you set the parameters related to the modulation of the program.
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Fan 2 |Mone

Fan '3 |Mone

LFO 1

This section lets you set the parameters related to the LFO1 of the program.
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LFO2

This section lets you set the parameters related to the LFO2 of the program.
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VerocityZone 1 (2, 3, 4)

This section lets you set the parameters related to the Velocity Zone of the program.

ol =l Lo e |r|| el ik

| ErY, Hi L= Eend

L F-r.

Wﬂ

Sample |Not Online

prom e e
o el i

Lo pring

Flaljback

26 The Sampler Editor

MESA Il



Envelope 1

This section lets you set the parameters related to the Envelope 1 of the program.

Ernvelope 1
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Envelope 2

This section lets you set the parameters related to the Envelope 2 of the program.
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Temperament

This section lets you set the parameters related to the tuning template of the program.

Termperarnent

Filter 2, Envelope 3, and etc. can be set if 2'nd Filter IB-304F (an option for some types
of Samplers) is installed on the Sampler.
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Sample Assign & Key Span Window

This window is used to assign samples, their keyspan, and their velocity zone for each
keygroup in a selected program.
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Audition samples On the keyboard at the top of Window, clicking a note key will play the sample.
The setting is performed on each keygroup. Setting items are as follows;
kg; Keygroup number
lo(hi); The key range can be typed from the keyboard or dragged
with the mouse.
Select velocity zones zn; Assign the samples in the Velocity Zone 1 to 4. By clicking
the upper number, the unnecessary zones can be hidden.
Assign key spans Span bar; Sets by dragging the key range with mouse. At the top left

window, the current note is displayed.

velocity lo (hi);  Sets the velocity range of each Velocity Zone.

keybd; Sets the pitch of sample play. Clicking the field with mouse
will toggle the setting between constant pitch and tracking.

You can use the Tab key to tab you through the different text field; use the Enter key to
turn off Tab.

Duplicate keygroups To duplicate keygroups, select "Duplicate keygroup(s)" from the Edit Menu.
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Memory Window

Check your Sampler's
available memory

Select programs

Set numbers and
channels

Rename programs

Be careful before
you save by drag
and drop - check
what exactly has
been selected

The Memory Window shows the programs and samples that are currently residing in
the Sampler memory. It also shows you how much Sampler memory is free.

]
The upper part of the window shows;
Programs in memory: Number of programs in the Sampler memory.
Samples in memory: Number of samples in the Sampler memory.
Program being edited: Name of the current program being edited.
Free memory: Sampler's available memory

The lower part of the window is divided into the Program List on the left and the Sample
List on the right.

The Program List shows the programs in the Sampler memory and their program num-
ber and MIDI channel. If there are several programs in the list, "."(bullet point) appears
to the left of the program being edited.

If you click on the program name, the program number and MIDI channel while holding
the Option key, you can rename the programs or set their value. You can also rename
the program by double clicking on a program name (same as selecting "Rename Cur-
rent Program..." from the File Menu).

The Sample List shows all samples currently in the Sampler memory. The samples

used for the currently edited program are shown with "." bullet point to their left.

When the sample on the Memory Window is selected, the speaker icon appears at the
upper right corner. Clicking on the speaker icon plays the selected sample through the
Sampler.

Files can be saved directly to your Mac or Sampler disks by dragging and dropping the
programs and samples from the Memory Window to the Finder or Disk Window.

The sample can be edited by dragging it to the Audio Editor Window. To edit stereo
samples, select both left/right samples of the same length and drag and drop them both
to the Audio Editor Window.

To select several items at the same time, click the items you want while holding Shift
key down.

To delete a sample or a program from the Sampler Memory, select it and press Delete
key or select "Clear" in the Edit Menu.
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Disk Window

Check what's on the
Sampler Disk

Select Sampler par-
titions and volumes

Load selected items
into memory

The Disk Window shows the contents of a floppy disk or the external SCSI devices
connected to the Sampler.
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The upper part of the window shows;
Floppy icon: Clicking this icon accesses to the floppy disk.
SCSlicon: Clicking this icon accesses to the SCSI devices connected to
the Sampler.

Total in volume: Total capacity of the currently selected volume.
Size of selection: Size of the selected item

The lower part of this window shows three columns: the Program List on the left, the
Sample List in the middle, and other miscellaneous files on the right.

When you click the SCSI icon, the volume list in the current partition of Sampler HD
(including CD-ROM, etc.) is displayed at the upper half of window. You can select the
partitions from the pop-up menu. You can enlarge this area by dragging the mouse
over the horizontal division bar.

Dragging and dropping the selected item from Disk Window to the Memory Window will
load them to the Sampler.

Note that drag and drop works only on the selected item and the associated samples to
the program will not be loaded automatically. To load all the associated samples with
the program automatically, select Load Selected Items using "Open..." from the File
Menu, or double click the program on the Disk Window.

Due to limitations in the MIDI protocol, you cannot rename disk volumes using MESA 1.
If you want to do so, use the front panel of the Sampler and update Disk Window.
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Quick Access Window

The main access
window for mixing
programs

Quickly access a
program's key pa-
rameters

The Quick Access Window provides an easy access to the key parameters in all pro-
grams and keygroups in the Sampler.
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All the programs in the Sampler are shown in the Program Field. Click on a little arrow
mark beside the program name, or select the program name and press Enter key; the
keygroup parameters will be shown.

The various parameters, such as program name, program number, MIDI channel, L/R
stereo volume and balance, individual output volumes, output assignment and tuning
can be changed here.

You can navigate around these parameter fields either by mouse, Cursor keys or Tab
key. If your keyboard doesn't have the Cursor keys, press the Caps Lock down and
use the number keyboard pad instead.

To change individual parameter values, use the mouse to drag the control or use the
Enter key to type in the value directly. You can also press + and - keys to nudge the
values stepwise up or down.

Mute Groups Window

The Mute Groups Window lets you set the Mute Groups in a program.

The keygroups in a program are grouped into 32 Mute Groups. Those keygroups
grouped in the same Mute Group humber mute each another. This function is mainly
used for special effects or drum Kkits.

With the program that plays several sounds simultaneously, you sometimes want to
override the polyphonic function and play only one sample. For instance, if you want to
follow an open high hat with closed one, you might want to stop the first as soon as the
second one plays. To do this, just assign both samples to the same mute groups, other
than 0. This makes the group monophonic and the open high hat will stop playing as
soon as the closed high hat, i.e. another sample in the same mute group, is played.
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Multi Window

Only XL-series Sam-
plers support this
function. This func-
tion is not supported
by §2800, S3000,
53200, and CD3000.

The Multi Window sets the multi mode parameters of the Sampler.
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The manipulation of this window is the same as that of Quick Access Window.
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FX Routing/Selection Window

The Effect related
windows open up
only when the EB16
Effect board is in-
stalled in the Sam-
pler.

The FX Routing/Selection Window sets the input/output parameters of 4 Effect buses.
It is also used to set the Effect and its routing to the current program.
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Mute:
External Input:

Output:

Program FX bus:

Keygroup FX bus:

Effect/Reverb pop-up menus:

Level and Pan section:

FX Routing dial:

Dir Signal:

& Saluciion

Switches On/Off the bus output.

Selects the bus connection of Left/Right sam-
pling input. Enables you to use the EB16 as
an Effect unit for external sound sources.
Sets the output of Effect (output connector on
the Sampler's rear panel).

Sets the Effect bus routing and its level for the
current program.

Sets the Effect bus routing and its level for the
current keygroup. The setting here has the
priority over "Program FX bus" setting. If "PRG"
is selected, the "Program FX bus" setting is
used.

From this pop-up menu, you select the Effect
and Reverb sets to assign to each Effect bus.
If you change the FX1 or FX2 set, RV1 and
RV2 may be changed automatically. Itis be-
cause RV1 and RV2 are linked together with
FX1 and FX2.

Sets the Output Level and Pan of various mod-
ules of the EB16.

Sets the bus control of Effect. A negative value
sets the level of signal from the Reverb passed
onto Modulation/Echo section. A positive value
sets the level of signal from the Modulation/
Echo passed onto Reverb section. If the value
of 0 is set, the Modulation/Echo and Reverb
become independent and they are used in par-
allel connection.

Switches on/off of the direct (dry) sound.

MESA Il

The Sampler Editor 33



Ring Mod/Distortion Window

The Distortion simu- The Ring Mod/Distortion Window sets the Ring Modulator and Distortion parameters.
lates the distortion as == Ri Mod £ Distortion

if the input signal is

overloaded. Freq  Depth Dristort Eitpid

The Ring Modulator Y Y y Y .

is an Effect of the in-
put signal being
modulated by the in-
ternal oscillator. Ex-
periment the sound

without any metallic Freq: Sets the modulation frequency

sound. Depth: Set the depth of Ring Mod Effect
Distort: Sets the amount of Distortion
Output: Sets the output level of Distortion
Bypass: Bypasses this module.

4 Band EQ Window

Made with the high The 4 Band EQ Window sets the Equalizer parameters.

rar'ige high-cut filter, SO0=—— 4 Band EQ 1
mid-range band-
pass filters, and low
range low-cut filter. figk
The modulation is
conducted in the
middle range filter,
and you can originate
the "auto-wah" Ef-
fect.

“fidth  Frood

Fid

Freq: Sets the EQ frequency

Level: Sets the EQ level

Width: Adjusts the Q of filter

Fmod: Sets the modulation frequency
Depth: Adjusts the amount of sweep.
Bypass: Bypasses this module.
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Modulation Window

The Phaser brings
the sound with so
called "swooshing"
Effect. The Flanger
also gives the sound
with the "swooshing"
Effect, but brings
more deep sound.
The Chorus gives
the effect like the
several music instru-
ments are simulta-
neously played.

Simulates the sound

The Modulation Window sets the modulation parameters.

There are 5 types of modulation functions available: one can be used selecting from
the "Function" pop-up menu.

Phase/Flange/Chorus

=|ll=——— Modulatiaon

Fhaze Flange S Lhor
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Mode: There are 3 types; the Phaser, Flanger, and Chorus

Speed: Adjusts the speed of phase Effect

Depth: Sets the amount of Effect

Feedback: Adjusts the amount of feedback from the Effect output to input

Rotary Speakers

of Rotary Speaker Modulation
Function |Rotary Speakers
. .rl'-l'-d 1 =T
FIE | EandEo]
s
apEEd1
Agce] D pdh
», ~
Speedl1/2: Sets the rotation speed of Rotary Speaker
Initial Speed: Sets the initial speed of Rotary Speaker effect: Speed 1 or 2.
Accel: Sets the time to take to switch between Speed 1 and Speed 2.
Depth: Sets the amount of Effect
MIDI Control: Sets the MIDI channel and MIDI Controller to allow switching
the rotation speed via MIDI.
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Freq Mod/Auto Pan

Experiment the Vi- : )
brato, Doppler effect, =|[JlI=———— Modulation

etc. 1 Maod £ &
<FMod>
Speed: Adjusts the modulation frequency
Depth: Adjusts the amount of Effect
Feedback: Adjust the feedback amount
<Auto Pan>
Speed: Adjusts the panning speed between the left and right
Depth: Adjusts the width of pan Effect
Mode: Sets the type of Effect
Pitch Shift
Makes up the pitch [I=—— Muodulation
shifted sound to the _
original sound Einction |Pitch Shift
Semi: Sets the amount of shift in semi-tone step
Cent: Sets the amount of shift in cent (1/100 of semi-tone) step
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Pitch Shift + Fdbk

Adds the delay effect [[I=———— Modulation |
on the pitch shift =

Finetion |Pitch Shift + Fdbk -

Righ

Eelaljs  Feedback

Semi: Sets the amount of shift in semi-tone step
Cent: Sets the amount of shift in cent (1/100 of semi-tone) step
Delay: Sets the delay time
Feedback: Sets the feedback amount
Bypass

Bypasses this module.
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Delay/Echo Window

Widens the sound by
overlapping the de-
layed sound to the
original sound

The Delay/Echo Window sets the Delay/Echo parameters.

There are 4 types of Delay/Echo functions available, Mono L, Mono L+R, Crossover
L+R, and Stereo: one can be used selecting from the "Mode" pop-up menu.

Delay:

Feedback:
HF Damp:

Offset:
Output:

Delay £ Echo

ono L

Feedbark

i ru
Bre

Adjusts the delay time

Adjusts the feedback amount

Sets the filter frequency to filter out the high frequency com-
ponent contained in the feedback signal

Sets the amount of offset for the feedback signal

Switches the module output: Pre/Post

To bypass this module, select Bypass from the pop-up menu.
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Reverb Window

Adds reverb to the

The Reverb Window sets the Reverb parameters.

original sound There are several types of Reverb functions available: one can be used selecting from
the "Type" pop-up menu.
Feverb
Type |Large Hall
Tirnet  Bre=Dalal = Diffiise
e EFEEamp  HE BErp
r
Time: Adjusts the time it takes to diminish the reverb signal
Pre-Delay: Adjusts the delay time of the reverb signal referenced to in-
put signal
Diffuse: Sets the amount of diffusion in the reflected sound
Near: Adjusts the distance from the original sound source
LF Damp: Cuts out the low frequency component of the reverb sound
HF Damp: Cuts out the high frequency component of the reverb sound
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FX Filing and Naming Window

Controls the Effect
file

Note that only one
Effect file can be
saved to one disk
volume in the Sam-
pler disk

This window will let you rename the Effect and Reverb names, and copy, save and load
the files.
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FX Filename: Name of Effect file. Click it with mouse to rename it.
Effects List: List of Effect set
Reverb List: List of Reverb set

When saving the entire Effect file to a Sampler disk, select "Save..." from the File Menu.

When saving the Effect files to the Mac, you can save either the entire Effect file, a
single Effect set, or a single Reverb set.

To save the entire Effect files, select "Export FX File..." from the File Menu.

To save a single Effect set or Reverb set, drag and drop the set from their list to the
Finder.

To transfer the entire Effect file back to the Sampler from your Mac, select "Import FX
File..." from the File Menu, or double click the file icon. You may also drag and drop the
file icon directly to the FX Filing and Naming Window or Memory Window.

To transfer an individual Effect set or Reverb set as a file on your Mac to the Sampler,
drag and drop the icon to the appropriate list of FX Filing and Naming Window.

To copy the Effect sets or Reverb sets, drag and drop them to the position where you
want them to copied to in the FX Filing and Naming Window.

Note that only one Effect file can exist in any one volume in the Sampler disk.

Loading files takes a few seconds as MESA |l transfers the new data to the Sampler.

40 The Sampler Editor

MESA Il



Audio Editor

In this chapter, the Menu Commands and Windows regarding the Audio Editor will be
explained.

Selecting the “Audio Editor” from MESA Il Editor Menu changes to the Audio Editor.

File Menu

New Audio Editor

Creates a new Audio Editor Window.

Open...

Opens a Audio file saved in your Mac. Acceptable file types depend on the “Audio
Filing” folder in the Plugins .

Close

Closes the active Window. When all the Windows are closed, the Audio Editor itself will
close.

Save

Saves an Audio file in the current active Audio Editor Window to the Mac. The file with
the same name will be overwritten.

Save As...

Saves an Audio file in the current active Audio Editor Window to the Mac with a different
name.

Save Selection...

Saves the audio data of the current selection to a new file on your Mac disk.

Record...

Opens the Record Window to enable you to record either from the microphone jack or
CD in the Mac. Refer to the Record Window described later in detail.

Quit

Exits MESA 1.
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Edit Menu

Undo
Allows you to undo the last edit operation.

Cut

Not enabled.

Copy

Copies selected 16 bit audio data to the clipboard (‘snd’ format)

Paste

Pastes 16 bit audio copied from the clipboard into the same Audio Editor Window,
another Audio Editor Window or any other Mac applications. The start of Pasted is the
insertion point of the Cursor.

Paste + Merge

Pastes 16 bit audio copied from the clipboard into the selected area of the Audio Editor
Window, and merges (mixes with present audio data) it.

Clear

Clears the selected audio to silence.

Select all

Selects the entire audio in the active Audio Editor.

Select None

Deselects the current selected audio.

Add Channel

Add a Right channel to mono audio. The existing mono audio becomes the Left channel.
Merge To Mono

Merges both sides of a stereo sample into a mono sample.

Cut Outside

Removes the audio before the start and after the end of the selected audio.

Left Channel Only

Disables the Right channel of a stereo sound. Copy/Paste/DSP etc. will only affect the
Left channel.

Right Channel Only

Disables the Left channel of a stereo sound. Copy/Paste/DSP etc. will only affect the
Right channel.

Both Channels

Enables both Left/Right channels of a stereo sound.
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View Menu

Set you Ruler Style

Choose your colours

The View Menu sets the parameters of Audio Editor display.

Tool Bar

Opens the Tool Bar Window. It contains the editing tools for working in an Audio Editor
Window. See the Tool Bar Window section for a detailed description.

Info Bar

Opens the Info Bar Window. It contains information about the audio in the active Audio
Editor Window. See the Information Bar Window section for a detailed description.

Sample Points

Sets the time display style to Sample Points for the Ruler.

Seconds

Sets the time display style to Second (S) for the Ruler.

mS

Sets the time display style to milli Second (mS) for the Ruler.

Sample Colour...

Allows you to set the sample colour for the wave form shown in Audio Editor Window.

Background Colour...

Allows you to set the background colour for the wave form display.

Default Colours
Sets the colours of Audio Editor Window to the default colours.
Fit

Fits the selected audio into the Edit Area of the Audio Editor Window.
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DSP Menu

First select the edit-
ing part and channel,
then use DSP.

Select the editing part and channel first, then use this DSP functions.

The DSP Menu contains various Digital Signal Processing functions. The options in
the DSP Menu corresponds to the DSP Pluglns that are present in the MESA Pouch/
Plugins/DSP folder.

DSP options currently include functions such as the Sound Increase/decrease by 3dB,
Audio Analysis, Filters for EQ, High/Low Pass and Fade, Noise Creation, Level Nor-
malization, Audio Reversal and Inversion, and Time Stretch.

Note that DSP functions are only performed on the selected part of the Audio Editor
Window. If you want to use DSP on the whole sample, you must select the whole
sample. Use the Edit Menu “Select All", “Select None”, “Left Channel Only”, “Right
Channel Only” and “Both Channels” to do so.

Each function is described as below:

+3dB /-3dB

Increases or decreases the level of wave form.

Analyse...

Shows the results of a fast Fourier Frequency Analysis.

EQ Filter...

7 band graphic equalizers. Use the mouse to adjust the individual filter.
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Fade...

Allows you to fade in/fade out in either logarithmic (Log) or linear (Lin) form.

High Pass Filter...

Sets the cutoff frequency to cut the lower frequency component of sound. Select the
filter slope: 6dB/Oct or 12dB/Oct, and adjust the gain.

Invert

Inverts the wave form up side down.

Low Pass Filter...

Sets the cutoff frequency to cut the higher frequency component of sound. Select the
filter slope: 6dB/Oct or 12dB/Oct, and adjust the gain.

Noise

Creates a random noise.

Normalise

Optimizes the amplitude of wave form. Maximizes the highest amplitude wave form.
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Quick Filter...

Integrates the High Pass and Low Pass Filters into the one window. Select either one

of them.
Frequency Gain
J) Lo Paz= Hi Paz= J)
& dB A0t 12 dB /0t
| 293K _ +0%5
Cancel | Quick Filter Ok
Reverse

Reverses the wave form front side back.

Time Stretch...

Extends or shortens the time axis without changing the musical tone.

Time Stretch
Original 5353

Eequired Length 5353

[ 2 ][ BPM |

Type Quality
{3 Musical Tones / Bass {1 Best (slow)
@ Speech/Music o Medium

{1 RhythmADrums 2 Quick

{_» High Frequency

Original: Sample Points (Sample Length) of original sample.
Required Length: Sample Length after performing the Time Stretch.

Type: Selects the type of sound source.

Quality: Selects the quality of Time Stretch. It will take a longer time

at Best selection. It takes less time in Quick mode, but the
quality of sound is not as good as that of Best.
Instead of specifying the number of Sample Points directly, you can press “%” button to
specify the ratio to the original sample. With the B.P.M button, you can specify the
Sample Length by specifying the number of beat (tempo) per minute and the number of
beat in one measure.
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Audio Editor Window

The main access
window for editing
samples

Load mono or stereo
samples

Title Bar Ruler
Start Marker Loop Start Marker \ Loop End Marker / / End Marker
E]
Overview |
Area
Edit Area -
Selected |
Area
(1]
Title Bar: Displays the sample name.
Ruler: Shows the location in the unit specified in the View Menu.
Overview Area: Shows the whole sample wave form. The area shown in
the Edit Area appears by surrounded dotted line.
Edit Area: Shows the sample wave form for editing. Possible to en-

large/scale down the display. When a stereo sample is
edited, the Left channel is shown in the upper area while
the Right channel is shown in the lower.

Start Marker: Shows the start point of sample play.

End Marker: Shows the end point of sample play.

Loop Start Marker: Shows the start point of loop.

Loop End Marker:  Shows the turning point of loop.

Selecting the Audio Editor automatically opens up an empty Audio Editor Window called
“untitled”.

You can open the wave form by drag and drop either the Audio file (AIFF) on your Mac
or the file name on the Memory Window of the Sampler Editor. You can also open the
file using “Open...” in the File Menu.

When the sample file is opened, the Audio Editor Window shows the sample wave
form and the name of sample in the title bar. The information on this sample will be
shown in the Info Bar Window at the same time.

The Audio Editor Window is split into two sections: the Overview Area on top and the
Editor Area below. You can turn the Ruler display on/off using the Ruler Switch.

Moving the Red Marker sets the start and end point of sample.
Moving the Blue Marker sets the start and end point of loop.

For a stereo sample, the left channel is shown on top and right channel is shown below
in one Audio Editor Window. When a stereo AIFF file on your Mac is opened, it opens
as one stereo file. A stereo sample in the Sampler is divided into left and right sample
files. When you drag and drop the 2 mono files of the same length to the Audio Editor
Window at the same time, they are automatically taken as a stereo file. Alternatively,
load a mono file, and using the “Add Channel” from the Edit Menu, you can paste
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Tools are described
in the Toolbar Win-
dow section below

another mono sample of the same length copied from other Audio Editor Window to an
empty right channel to make a stereo file.

If a stereo sample is saved to your Mac from the Audio Editor Window, it will be saved
as one stereo AIFF file. If you drag and drop a stereo sample to the Memory Window of
the Sampler Editor, it will be saved as two separate mono files.

You can either click the Play/Stop button or press the Spacebar to play the selected
audio.

To make it visually more apparent what you are editing, use the Zoom Tool to expand or
shrink the visual display of the sample you selected. Using the View Menu, you can
even change the colour scheme of sample and background. Note the Info Bar Window
- it tells you the length of sample, the selected part, and the loop. You can even set your
parameters from there.

You can use the Ruler Switch to help you navigate, and if you want to restore the
window to a broader overview, use the Fit Tool.

You can now manipulate the selected part using the Pencil Tool for wave form drawing
(e.g. editing out noise) or make up the sample to meet your purpose using DSP func-
tions.
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Tool Bar Window

Select a Tool and
edit a sample with it

Press Command key
if not already se-
lected.

Press Command key
if in Arrow Tool
mode.

Press Option key.

Press Control key.

The Tool Bar Window provides tools and transport controllers to edit samples. If the
Tool Bar Window is not open, select “Tool Bar” from the View Menu.

The drawing of the Tool Bar Window are;

Arrow Tool SelectionTool
Zoom Tool Speaker Tool
Drag Tool Pencil Tool
Play/Stop Tool Fit Button

Enlarge (V) Button Shrink (Y) Button

Enlarge (H) Button Shrink (H) Button

Ruler Switch Loop Switch

Note that the top six blue icons are the Tool buttons. The Cursor will change its shape,
as the same as the tool buttons while the Cursor is within the Audio Editor Window,
when you select one of them. The eight lower icons in the Tool Bar Window are the
control buttons.

The following tool are available.

H- |Arrow Tool

Sets the start and end markers (red markers) of samples or of the loop (blue markers).
Also moves the area where is surrounded with dotted lines in the Overview Area. This
tool is available whenever you press the Command key.

I |Selection Tool

Use this tool to select a part of sample. To deselect, use the selection tool and click on
anywhere in the window. DSP functions, editing, etc. are effective only to the selected
part.

Q. |Zoom Tool

You can zoom in (drag the part you zoom in) or zoom out (click while holding SHIFT
key). This tool is available whenever you press the Option key.

cJi |Speaker Tool

Plays from any part of the sample with this tool. Click and hold the mouse or drag it to
play. This tool is available whenever you press the Control key.
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Spacebar does the
Play/Stop functions
Select the area in the

Overview Area and
this shows the se-
lected area in the Edit
Area.

Play with four types
of Zoom in/Zoom out
Buttons - No change
to the sample itself.

Drag the loop mark-
ers to adjust the loop
point

@Drag Tool

You can drag the wave form from the Audio Editor Window and drop it to the Finder or
to the Memory Window in the Sampler Editor to save.

?-:1 |Pencil Tool

Enables you to draw wave form freely. You can remove the noise, etc. by actually
drawing the wave form.

k® \Dlay/Stop Button

One click plays the sample and the second one stops it playing. If the Loop is not set,
the play stops at the end point of play. If the part of sample is selected, it will play only
that part. Same goes for the Spacebar.

[ 4 |Fit Button

Fits the selected part of sample with the Selection Tool to the Edit Area. If no part is
selected, the whole sample will be fitted.

+ |Vertical Zoom Enlarge Button

Enlarges the wave form in the Edit Area vertically.

+ |Vertical Zoom Shrink Button

Shrinks the wave form in the Edit Area vertically.

+* |Horizontal Zoom Enlarge Button

Enlarges the wave form in the Edit Area horizontally.

4 |Horizonta/ Zoom Shrink Button

Shrinks the wave form in the Edit Area horizontally.

Ty |Ru/er Switch

Switches the ruler display on and off on both the Overview and Edit Area. When the
Ruler is On, its icon is highlighted. The unit of ruler changes between Sample Points,
Seconds and mS via the View Menu.

C:]|Loop Switch

Turns the looping mode on and off. The sample is played repeatedly between the loop
markers. While the loop mode is set to on, the loop markers are shown in blue and its
icon is highlighted.
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Info Bar Window

The Info Bar Window shows the information about the sample in the Audio Editor Win-

dow.
Displays the infor-
mation about the
sample being edited
Rename the Sample
directly in the Title
bar
Change the display To open the Info Bar Window, select Info Bar from the View Menu.
unit selecting from If several Audio Editors are open, the information shown is for the currently active
the View Menu Audio Editor.
Title Bar: Shows the sample name
Rate: Shows the sampling frequency
Note: Shows the basic MIDI Note
Length: Shows the sample length
Start: Shows the start point of sample play
End: Shows the end point of sample play
Lp st: Shows the start point of Loop
Lp end: Shows the end point of Loop
Sel st: Shows the start of selected part
Sel end: Shows the end of selected part
Cursor Point: Shows the Cursor location in the Audio Editor Window

Clicking on the field (white field) of the Info Bar Window, you can directly enter the
parameter values from the keyboard.

The Loop point and Selection point will not be shown in the Info Bar Window, unless
they are set accordingly.
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Record Window

The Record Window opens up when “Record...” is selected from the File Menu. In this
Window, the sample will be recorded on your Mac, but not recorded on the Sampler.

Sampling Rate Record Mode Record Time Field  Sample Name Field

\ AN /
\I Mana \ /

[] 4=000 Secs: | 2
[l 44100 [] stereo Mame: New Sample
[] zz0s0 [ autae Gain

. m =

a4 l \ N\

Auto Gain Indicator Record Button  Stop Button Input Select Button

Sampling Rate: Selects the sampling frequency

Record Mode: Selects either mono or stereo recording.

Auto Gain: When this is set, the gain of input signal is adjusted
automatically.

Record Time Field: Sets the recording time

Sample Name Field: Names the sample

Record Button: Starts recording

Stop Button: Stops recording

Input Select Button: Opens the Selection Window for the recording
source

Indicator: Indicates the recording level

To make a recording, after setting the sampling frequency, record mode, record time,
and sample name, as well as selecting the input source, click on the Record Button.

MESA Il warns if you select the sampling rate which is not supported by your Mac.
Turn the Auto Gain on as necessary.

The recording is stopped when it passes the record time or when the Stop Button is
clicked - the new Audio Editor Window will appear.
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MIDI Keyboard

MIDI Keyboard Editor provides a very basic Mac interface to let you play MIDI Notes
with the little keyboard on the screen to the Sampler over MIDI. For this communica-
tion, OMS MIDI must be installed on your Mac.

You can play simple
MIDI notes without
using an external C1 cz C3 C4 C5

Wib! keyboare. BB GG )5 (o Jvetosity
Co a0 zl0=]0a]0s]0e]) Coms )

!

(1] &1 Motes Off &
l
Keyboard: Clicking mouse sends MIDI Note
MIDI Channel 1 to 16: Selects MIDI Channel
Velocity: Sets the velocity value of MIDI Note
OMS: Sets the output ports
All Notes Off: Sends “All Notes Off” message
Sustain: Switches the Sustain pedal on/off
Rand: Sends the MIDI Note at random

To display the Keyboard Window, select “MIDI Keyboard” from the Editors Menu and
then select “Open Keyboard Window” from the File Menu.

To run the MIDI Keyboard, the file Keyboard must be placed in the “Editors” Folder and
the OMS Plugin file must be present in the “Plugins” Folder.
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DD1000 Transfer Module

Use this for Audio
File Transfer be-
tween the DD1000
and MESA I

=[I== DD1000 Audio Transfer ==m4]
it ks

- -

{1

The DD1000 Transfer Module provides the connection between MESA Il and DD1000.

In this window, a list of "Takes" (i.e. the recordings on the DD1000) is shown on the left

and the list of Cuts for the selected Take on the right.

To load Cuts from the DD1000 for editing, drag and drop them to the Audio Editor

Window.

To save Cuts form the DD1000 to your Mac hard disk, drag and drop them to the

Finder, or select "Save Selected Cuts" from the File Menu.

To save Cuts from the DD1000 to the Sampler hard disk, drag and drop them to the

Memory Window in the Sampler Editor.

To save any audio file as a Take from MESA Il to the DD1000, drag and drop the file into

the DD1000.
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MESA Il AppleScript

Use AppleScript to
extend the function-
ality of MESA Il and
to improve your work
efficiency

Scripts must be
saved as applica-
tions

MESA Il comes with
a useful suite of
scripts

Troubleshooting in
AppleScript

AppleScript is available to Mac user as part of the Mac OS (version 7.5 or later), and is
a very simple programming language that can be used as very powerful method to
perform "batch" operations automatically on the data in an application.

MESA Il is fully compatible with AppleScript. Scripts can therefore be written to per-
form a wide variety of useful "powerful functions": for instance, a script "Set individual
Levels" included with MESA Il (compile it and save it as an application first) allows you
to set the individual outputs of all selected programs by a simple click with the mouse.

For reasons of variations in individual Mac hardware, software, and OS setups, the
scripts included with MESA |l are test files that first need to be compiled on your com-
puter to run. To compile these scripts, you must start the AppleScript Editor program
which is an application included in the Mac OS. Load the script source code into the
editor and compile it. Those several lines after "?", "comment" commands in the source
code explain the purpose of scripts. Before saving, check if the script runs appropri-
ately within MESA 1l by clicking the "Run" button, then save it as an application. Then
you simply click its icon in the Finder to run it.

The scripts provided with MESA Il include functions that allow you to;

* set selected programs to incremental program numbers (Renumber Pro-
grams)

* replace all programs in the sampler with 8 new programs (8 New Pro-
grams) whose

-- MIDI channels are set from 1 to 8,

-- individual outputs are set from 1 to 8,
-- stereo levels are set to zero,

-- individual levels are set to 90

* create a stereo program containing the 2 selected samples in the Memory
Window (Make Stereo Chromatic Program)

* set MIDI channels of all selected programs incrementally from 1 to 16
(Incremental Channels)

* set the individual outputs of all selected programs incrementally from 1 to
8, turns off stereo output and set the individual output levels to 90 (Incre-
mental Outputs)

* create programs containing a sample for each sample selected in the
Memory Window (Mono Programs from Samples)

* set the key span of each keygroup in the selected program in the Memory
Window to a single note in a chromatic scale, and one note is set as the
one keygroup (Chromatic Keyspan)

* set each keygroup in the selected program in the Memory Window to the
constant pitch (All KG to constant pitch)

* add a user specified number of keygroups to the selected program in the
Memory Window (Add keygroups to program)

Notes in Writing AppleScript

Some of the scripts included with MESA Il depend on the actual configuration of your
system. For instance, some of the example scripts refer to system objects such as

MESA
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Write your own
Apple Script

Save the scripts you
like as applications
and store them in a
new folder in the
Apple Menu Folder -
run the scripts se-
lecting from the
Apple Menu.

Find out more about
AppleScript

"Display Dialogue" ("Display"). If these scripts do not work on your system, either
remove the references files of the offending objects or try to recover the missing ob-
jects. In your extensions folder in the system folder, there should be the system script
objects stored in a folder called "Scripting Additions".

You will definitely need the following objects to be present for MESA Il scripting:
° Display Dialogue "display"
° File Commands "file command"
° New File "new file"
° Read/Write Commands "read/write commands"

Explanation of terms in MESA Il Script

Every scriptable application like MESA Il has a "Dictionary" for all commands and pa-
rameters that can be set in your script. To see if an application is scriptable you simply
drop it onto the "Script Editor" application in the Finder. By examining the dictionary of
a scriptable application, you will be able to see which commands and parameters of
MESA Il you can manipulate with AppleScript.

MESA |l provides a subset of the 'core' Apple Event Suite which is called MESA Suite.
Some editors provides extensions to the MESA Suite. For example, the Sampler Edi-
tor provides the Sampler Suite. These extensions may provide extra parameters ("prop-
erties", "elements", or (also called "objects") and "events") (also called as "commands")
for the MESA 1l applications such as "sampler" element in the Sampler Suite. These

extra elements can then be accessed via the "application" element in the MESA Suite.
For example the script command
get sampler 1 in application "MESA 11"

will return a reference to the sampler element in the Sampler Suite. You can then use
that reference to get at the elements and properties in the Sampler.

Here is a simple example of script that sets the name of the first program in the AKAI
sampler that is connected to MESA I

tell application "MESA II"
set name in program 1 in sampler 1 to "PROGRAM 1"
end tell
Of course, most scripts are far more complex than the above example.

You should look at some of the example scripts provided in the "Example Scripts"
folder included with MESA II.

To find out more about how to write scripts using AppleScript, you should read the
documents called AppleScript Language Guide and Scripting Additions Guide which
should come on your AppleScript installation disks. There are also some good books
on the subject which you should be able to find in the computer section of any good
book store or Mac computer dealer.
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Troubleshooting

Symptoms
MESA Il does not boot

The Mac freezes

No access to external
devices

Suspected Cause
The file is not in the correct loca-
tion.

Necessary extensions are not in-
stalled.

Preference file of MESA Il is cor-
rupted.

The file is corrupted.

Several devices use the same
SCSI ID.

The Mac and Sampler booted si-
multaneously.

SCSI termination problem

Old version Sampler

The cable is not connected

The virtual memory is on.

SCSI ID setup problem

Troubleshooting

Check that the Editors and Pluglns that you want to
use are in the "MESA Pouch" Folder, and this Folder
resides in the same directory (location) as the MESA
[l application.

If you run an older Mac System OS than v 7.5, check
whether you have the necessary extensions in-
stalled. Details are given in the Memory, Systems
Requirements and Set-Up sections in this manual.
If you do not have these extensions, you will have
to upgrade your Mac Operation System.

Delete the "MESA Preference" Folder from the Pref-
erence Folder in the System Folder. If you boot
MESA 1l, a new "MESA Preference" Folder will be
automatically created.

Reinstall MESA II.

Set the unique SCSI ID numbers to each device
connected via SCSI.

The conflicts (collision) in SCSI in initial routines
are caused because both the Mac and Samplers
are equally SCSI targets and SCSI initiators when
they are turned on at the same time. To avoid the
conflicts between multiple SCSI devices, you should
turn on the external SCSI devices like the Sampler
first and let them settle before turning on your Mac.

You might need to remove the terminator of a built-
in hard disk as there is a terminator on the SCSI
card in the Sampler.

If you use S2800 , S3000, S3200 and CD3000, you
must have at least v1.68 or later version system
softwares.

If you use SCSiI, check if the SCSI cables are con-
nected securely.

If you use OMS MIDI, check if the OMS setup has
been set correctly, and if the MIDI cables are con-
nected properly.

When the SCSI is used, turn off the virtual memory,
including RAM doubler, in the Memory Control
Panel.

Check if the boot-up routines and SCSI setups are
appropriate. Be sure to set the correct SCSI IDs.
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No AppleScript func-
tions

Large samples not
loaded

AppleScript has not been installed
correctly.

Allocated memory size is not
enough.

Reinstall AppleScript.

If you are running Mac OS v 7.5, you can rectify
this easily as it comes with a complete AppleScript
Setup Installation. If you use System 7.1 or earlier,
you will need to install both AppleScript and a script-
ing Finder available for scripting. If you still experi-
ence problems, contact the Apple dealer how to get
the AppleScript.

Select MESA Il icon from the Finder, and select "Get
Info..." from the "File" Menu to change the memory
allocation.
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